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You are required to start every new document using a template, whether or not the document 

will be posted on the website. If you need to write a document that does not fit into one of our 

standard product categories, you should use the general template that incorporates the standard 

CTPS styles without the formatting specific to the other product types. Simply write your 

document in the general template and apply the styles properly throughout

You should always meet with Editorial and Graphics to discuss the format of your document. 

While all documents begin in the templates, you may want to create a more visually appealing 

document. It is important to consult with Editorial and Graphics prior to beginning your 

document to determine which template to use and the budget required for their time.

The instructions in this document are written to be used on a PC with Microsoft Word 365, the 

Word version being used at CTPS as of 2022. Refer to the software documentation for Word 

functions and features if using a different version of Word or a Mac. 
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Style Overrides
DO NOT USE!

Style 
Pane

Bold and Italics
may be used when 

necessary

Bullets/
Numbering

Increase/
Decrease Indent

Line and Paragraph Spacing
(use for bullets that run 

longer than one line)

Home Tab
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It is the sole responsibility of the AUTHOR to make sure that their document 
gets through ALL steps of the document production.

This includes meeting other groups’ deadlines for processing and making sure 
that your document is posted online in accessible HTML and PDF formats.

Be sure to read through this guidebook to make sure you are  
formatting your document correctly..

A member of the Editorial or Graphics Group will be happy to answer any 
questions you may have.

BEFORE YOU BEGIN

Before starting any documents, get approval from the directors and your manager. 
See the Work Scope Accessible-Document Product Process flowchart in the Appendices.

 
PLANNING YOUR DOCUMENT

How do I determine which template to use?

Most templates are basically self-explanatory. For an agenda, use the appropriate Agenda 
template; for minutes, select a Minutes template. If you are unsure whether to use a memo, 
briefing, or report template, please talk to Editorial. 

Do I need a cover?

If you are writing a report, you will need a cover. Before you begin your report, talk to Graphics 
about creating a cover. Graphics will also provide you with a map for the map page of your report.

What if I want my document to look a bit different than the template?

When planning your document, you should meet with Editorial and Graphics to discuss the type 
of document you envision and to determine the budget for their time producing the document. 
This is particularly important if you would like your report to look different from the report 
template. For example, you may want to create a document with a different layout than the 
report style or a guidebook, both of which would use a report template for the text but would be 
designed by the Graphics team for layout. Please discuss with the managers of the Graphics and 
Editorial at the start of your project for more information
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Where can I find images to use?

A library of photos and icons can be found in the Graphics folder under Groups on the shared 
Google drive. You may also browse photos online at ShutterStock.com, or request an illustration 
from the Graphics team. To request an image you want from ShutterStock, please copy and paste 
the URL into an email and send it to Graphics@ctps.org. The Graphics Team will then download 
the photo and send it to the requestor.

Does my report have to follow the look of the template?

Because of accessibility guidelines, you will need to create any report content in the template 
to submit to Editorial. You should meet with members of the Graphics Team and Editorial if you 
would like something that looks different from the template. Examples of these types of designed 
reports are located on the “Templates” page on the intranet.

Be aware that you must start this process at the very beginning of your project (during the 
scoping process). This level of creativity requires significant time and will require a larger budget 
than you would use for a standard report template.

Will I need to update the information on the website?

Talk to the Deputy Executive Director, Manager of Data Management, and Manager of 
Communications and Engagement if you feel that you need to update information on the 
website.

How will I arrange for a special announcement when my document is released?

If you would like a special announcement about the release of your document via the 
website, email, or our X (formerly known as Twitter) page, please consult Graphics and the 
Communications and Engagement team. 

Can we still collaborate with our team in Google Docs?

You may still work on a project with your team in Google Docs; however, you must then insert 
the text into the report template before sending it to Editorial. Please note that simply copying 
and pasting the material into the template will bring over the styles from your work in Google 
Doc. Please remove all styles before copying the text into a new template. One way to do this is 
to transfer your text into a text editor such as Notepad, which will strip the styles. You can then 
transfer your text without styles from Notepad into the template and apply the appropriate 
styles. Another way is to copy and paste your text into the template, select all of your text and 
then select Normal from the expanded Styles pane. Then you will need to apply styles such as 
headers throughout the document. 

You can also paste as Keep Text Only under you paste selections. On a Mac, under the paste 
options, you can use Paste Special and select unformatted text.

For other options, refer to Quick Guide #2.

http://ShutterStock.com
https://intranet.ctps.org/templates-home
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BEFORE YOU BEGIN WRITING

The Editorial Team can walk you through the writing and formatting process before you begin. 
Contact a member of Editorial to schedule a meeting to discuss formatting your document. In 
addition, a member of Editorial will be happy to meet with you at any time during the process  
(e.g., writing or during the editing process) to clarify any editing marks and answer any questions.

WRITING YOUR DOCUMENT

•	 You must download a new template every time you begin a new document. Downloading 
a new template ensures that you are working with the most up-to-date template and 
guarantees that screen-reading software will be able to follow the document without issue. 
The date of the latest update is located next to the document on the templates page.

•	 Download the appropriate template from our CTPS intranet site (https://intranet.ctps.org/
templates-home). 

•	 Begin your work in the Microsoft 365 program/application on your computer rather than the 
browser version, as some of the template features are not available in the browser version.

•	 Name your document according to the CTPS file-naming protocol. (See How Should I Name 
My Document? on page 10.)

•	 Write your document according to the standards found in this guidebook and the CTPS 
Editorial Style Guide located on the intranet.

•	 Apply appropriate styles throughout your document. (See How Do I Apply Styles on page 12.)

•	 Distribute your draft to all internal reviewers (e.g., group manager, director, etc.) and 
incorporate any changes from internal reviewers before submitting your document to 
Editorial. 

•	 Submit your document to Editorial by following the instructions in the Editorial Submission 
button found on the home page of the intranet.

•	 Review your edited document when returned and either ACCEPT or REJECT edits using Track 
Changes. 

•	 Maintain version control within the file-naming convention as you work with Editorial. 
Author versions always end with a number. Editorial versions always end with a letter as 
shown in the example on the next page.

•	 Continue the editing process until you and Editorial agree that the document is complete. 
Editorial will create a Client Review Draft to be reviewed by the client prior to finalizing 
the document. After the editorial process is complete, Editorial will remove the DRAFT 
watermark and label your document as FINAL.

https://intranet.ctps.org/templates-home
https://intranet.ctps.org/templates-home
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HOW SHOULD I NAME MY DOCUMENT?

All documents must adhere to the following naming protocol shown below:

•	 There is only one space between characters—no underscores, hyphens (except in date), or 
any other symbols, unless they occur in the actual document name.

•	 Use title-style capitalization (not all caps or all lowercase letters).

•	 Your title must not exceed 60 characters.

•	 If your initials are the same as another colleague, please provide your first, middle, and last 
initial or your last name in place of initials to avoid confusion.

Author File Name
2021-10-28 Early-Morning Transit Service MEM JB 1

Editor File Name
2021-10-28 Early-Morning Transit Service MEM JB 1a

Early-Morning Transit Service

Document Name
(Recognizable, 

descriptive, and brief)

MEM

Product Type
Suffix

(See below)

JB

Author 
Initials

1,2,3, or FINAL

Version

2025-07-03*

Date Submitted 
to Editorial

*MUST be the same as the 
date of online submission

CTPS Product Type Suffixes

ALT = Alternative Text LTR = Letter PPT = Presentation TIP = TIP

BRO = Brochure LGL = Legal Notice PRR = Press release TXT = Miscellaneous Text

FIG = Figure LRTP = LRTP REP = Report UPWP = UPWP

FLY = Flyer MAP = Map SCP = Scope WEB = Web Content

JAD = Job Ad MEM = Memo TBL = Table
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WHAT ARE STYLES AND WHY DO WE NEED THEM?

Various laws and regulations set the standards for the accessibility of electronic media.  CTPS 
meets these requirements by formatting all text and documents that appear on the MPO’s 
website using MSWord Styles. Styles allow individuals who use a screen reader to navigate 
documents easily.

Templates have been developed for each of the product types that incorporate the appropriate 
styles to make the documents both screen-readable for those with a disability and consistent 
with CTPS’s graphical standards.

The Styles pane is a quick formatting tool located on the Home tab of the Ribbon at the top of 
your Word document. Using a pre-set style automatically changes the formatting of your text. 
We use Styles to ensure consistent formatting across all our documents and to adhere to CTPS 
standards for accessibility. Using a different style for headings than for the text in the body of a 
document is a quick and easy way to provide visual cues for sighted readers and makes it easier 
for those who navigate documents using screen readers.

The correct application of styles on headers throughout the document builds the table of 
contents when one is needed. In addition, appropriately applied styles are essential to convert 
documents into PDF and HTML files that are accessible. By law, CTPS must produce such 
documents.

Style 
Pane
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HOW DO I APPLY STYLES?

Two clicks: simply place your cursor within a line of text, and then click on the appropriate style. 
You’re done! The style will be applied to the entire line or paragraph. You may apply styles as you 
write, or you may apply them after you have typed all your text. Text that has not been assigned 
a specific style will default to the Normal style, so you will only need to apply styles to text that 
requires additional formatting, such as headings or footnotes.

Once a style is applied, you do not need to format the text further. For example, you will not need 
to change the indentation, font weight, or spacing before/after a heading manually. You should 
not insert a blank line (i.e., hit Enter) after a heading style, but you should insert a blank line 
between paragraphs of text.

It is very important that you do not use the Font tools on the Home tab of the Ribbon that allow 
you to manually change the font, point size, color, etc. These commands will override the styles, 
such that you will end up creating more work for yourself and for those who will turn your 
document into an accessible HTML file. 

Bold and Italics are okay to use on specific words you wish to highlight within your text where 
appropriate, but do not use them to change the look of your headings or paragraphs of text.

Please contact the Editorial or Graphics group for questions or assistance with your document.
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OTHER STYLE CONSIDERATIONS

How do I convert my memo into a report?

What if the template is updated while I’m in the middle of writing a document?

What if I need to update an old report?

The same process applies in all these situations:

If you have large amounts of text to transfer into a new document, there are some tricks to get 
it done quickly and efficiently. Download the new/appropriate template and rename the file 
using the correct naming protocol. Highlight all of the text in your original document then Copy 
and Paste it into a text editor, such as Notepad, which will clear any styles built into the original 
document. Paste the content into the new template and apply the styles appropriately. If you are 
copying from an old template into the new template, you simply Copy and Paste. If the styles are 
applied correctly in the old template, they will update and reformat automatically. See page 8 for 
other options.

If you are unsure whether to use a memo, briefing, or report template, please talk to Editorial.

My styles didn’t update in the new template, now what?

If your styles didn’t automatically update, it means you didn’t apply the style correctly, or you 
used the formatting buttons to override the style. Highlight the incorrectly formatted text and 
click on the Clear Formatting button found in the expanded Styles panel from the Ribbon in the 
Home tab, then reapply the appropriate style.

Clear 
Formatting
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How Do I Make a Bulleted or Numbered List Using Styles?

Type your list using the Normal style. Highlight the text to be bulleted or numbered, then click 
on either a Bullets or Numbering button located in the Paragraph group on the Ribbon under the 
Home tab.

For sub-bullets, highlight the appropriate text and hit the adjacent Increase Indent button. 
Repeat the process for sub-sub-bullets, etc. The Decrease Indent button will shift the text back a 
layer. If you have any questions about how your list should be bulleted, please see the Editorial 
Style Guide or speak with a member of Editorial directly.

Increase 
Indent

How Do I Format Tables?

See the Tables section of this guidebook on page 59.
 

WORKING WITH GRAPHICS AND ACCESSIBILITY FORMATS

Write your document and apply the correct styles throughout. Once your document is through 
the editorial process and finalized, send it to Graphics (graphics@ctps.org) to be made into 
accessible PDF and HTML files. Graphics will notify you when your document is ready for posting 
on the MPO website. The Graphics group has its own number to charge this work to (Provision of 
Materials in Accessible Formats) and will not charge your project.

Can’t I just make the PDF file myself?

No. Some versions of Word and/or Adobe Acrobat do not support the creation of Tags, which are 
necessary for screen readers. There are also several “behind the scenes” steps that Graphics must 
take to ensure that the PDF meets accessibility standards.

Decrease 
Indent

mailto:graphics%40ctps.org?subject=
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Word has a “Save as HTML” feature. Can’t I just make my HTML that way?

No. Word is NOT a good program for creating HTML files. Creating HTML files directly from Word 
creates a lot of bugs and coding problems. Graphics has the appropriate software for web coding.

Can’t I save time by giving Graphics the document before the editorial review 
is finished?

No. Giving Graphics your document before it’s finalized will slow down the process. Graphics will 
only accept files that are FINAL.

What if my document has to go through phases before being FINAL?

We understand that some documents need to go through several phases (i.e., public comment 
period, MPO approval, etc.). Please consult the Editorial and Graphics groups when you move on 
to the next phase of your document’s production.

WHAT IS ALT-TEXT AND WHY DO I NEED IT?

Alternative Text (or ALT-Text) is text that is unseen, but that is read by screen readers. It is used for 
tables and figures/images that a screen reader would otherwise skip over or read only as “image.” 
Authors must write a short one- to two-sentence summary for all tables and figures to comply 
with CTPS’s standards for accessibility. Please see Editorial if you need a sample of ALT-Text.

What Should I Write as ALT-Text for a Table or Figure?

•	 A screen reader will continuously read a table left-to-right without pausing or providing 
context. The most helpful alt-text for a table describes its overall organization. For 
example, “Individual projects head each row, followed by columns of funding information.” 
For figures, alt-text should include a basic description of what the image or map is 
displaying.

•	 Please talk to Graphics to make sure that your table and figures adhere to accessibility 
standards.

•	 If, after consulting with the Graphics group, you need to use a complex table, use 
the following language as your ALT-text:  

This is a complex table that has not been optimized for screen-reading software. If you would like 
to request this data in a different format, please contact the Central Transportation Planning Staff 
(CTPS) via email at publicinfo@ctps.org.

mailto:publicinfo%40ctps.org?subject=
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POSTING TO THE WEBSITE

When Graphics has completed making the PDF and HTML files of your document, they will email 
you to let you know the files are ready and to give you the location of the files. You are then 
responsible for contacting the appropriate department to have your document posted on time.

For MPO meeting materials, Graphics will notify you and a member of MPO Activities of the 
location of the final document. A member of MPO Activities will post the document to the 
meeting calendar.

For all other website postings, Graphics will notify you directly. Refer to the instructions on the 
intranet regarding web postings.

I STILL DON’T UNDERSTAND!

A member of the Graphics or Editorial staff is available to help you with any problems or 
questions you may have.

https://intranet.ctps.org/website-content-requests
https://intranet.ctps.org/website-content-requests


WORK PLANS
AND PROGRAMS
Starting Out

Additional Formatting

If Your Project is Related to Another Project

Preparation for Editing and Posting
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COLLABORATIVE PROJECT SCOPE DEVELOPMENT 
 
Project Name 

 

Project Number  
Project Manager  
Project Principal  
Group Manager  

 

Instructions to project manager 
1. Complete the information above. 
2. Begin scope development by meeting with staff from other groups who may be 

contributing to the project. Always include staff from those groups that provide support 
(Editorial, Graphics, Communications and Engagement, and Data Resources), even if 
you do not think you will need their services. 

3. Develop the project’s tasks, estimated person-weeks of work, work products, and 
schedule in consultation with relevant group managers. Write this information in the 
template in the following pages and the cost table and schedule in the template exhibit 
workbook accordingly.  

4. Before the first editorial review, complete the top and bottom sections of this form. Be 
sure to enter additional support groups as required in the Approvals section below. 

5. Once Editorial has returned the final version of the work scope to you, submit this form 
along with the final work scope, cost table, and schedule to the Director of Finance and 
Operations, who will usher it through DocuSign to obtain the required e-signatures. Each 
signatory must complete the name and date lines to certify approval. The Director of 
Finance and Operations will return a copy of the signed form to you.  

6. Prior to sending the work scope to Graphics, where the document will be prepared as a 
PDF and HTML for posting, remove this form. 

7. Set aside amounts specified for support group staff in the cost table exhibit and, while 
tracking project expenditures versus budget, consider the set-asides off-limits for any 
task other than the intended purpose. In cases where the products were not well-defined 
during initial project scoping, consult with relevant group managers to revise these 
amounts once the products are better defined. 

8. Your project principal or group manager monitors the project’s progress and ensures 
proper management of this and all other aspects of the project. 
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If you need help using the template or have any questions, please see someone 
in the Editorial or Graphics group.

Remember to apply styles throughout your document. Refer to the
Getting to Know the Process section of this guidebook to make sure that you 

are applying them correctly.

A work plan is a short scope of work that may be used for a project that is funded entirely by an 
agency or other non-MPO client. Work plans are used only under certain circumstances and/or 
for specific projects. Work plans may not be used for MPO-funded work and do not require review 
and approval by the MPO.  

A work program is a scope of work that will be reviewed and approved by the MPO, regardless of 
the funding source. There are two work program templates, one for MPO-funded work and one 
for agency- or other client-funded work. Always double-check with your group manager and/or 
director if you are uncertain whether a scope is a work plan or a work program.

 
STARTING OUT

•	 Download the work plan or program template from our intranet site (https://intranet.ctps.
org/templates-home) to ensure that you are working with the most up-to-date templates. 
Rename your document according to the CTPS file-naming protocol. (See How Should I 
Name My Document? on page 10.)

•	 Change “Boston Region Metropolitan Planning Organization Work Plan (/Program)” found 
in the Title field of the document Properties to the current title of your document and the 
current date. To access the Title field, click the File tab at the top of your Word document 
and select Info in the left navigation. The Title field is to the right under the image of the 
document and the Properties header. To change the text, click in the field and replace the 
existing text with your new information.

•	 The first page of the work scope template, the Collaborative Project Scope Development, 
should be completed once Editorial has returned the final version of the work scope to 
you. Submit this form along with the final work scope, cost table, and schedule to the 
Director of Finance and Operations, who will usher it through DocuSign to obtain the 
required e-signatures. Each signatory must complete the name and date lines to certify 
approval. The Director of Finance and Operations will return a copy of the signed form to 
you. Prior to sending the work scope to Graphics, where the document will be prepared as 
a PDF and HTML for posting, remove the form.

•	 Replace all text enclosed in square brackets, including the brackets themselves, with 
appropriate text, as directed by the text in brackets.

•	 Add the appropriate information in the header of the second page.

https://intranet.ctps.org/templates-home
https://intranet.ctps.org/templates-home


20  |  Document Production Guidebook

W
O

RK PLA
N

S A
N

D
 PRO

G
RA

M
S

•	 To ensure consistency, you are required to use the exact format and wording in the work 
plan/program template. Some exceptions may be made. Talk to your manager if you need 
to change the wording. 

•	 On the first page of the scope, add information only where the brackets prompt you to do 
so. Make sure you delete the brackets. It should never be necessary to change the main 
headings: Do not add or delete headings, reword them, or change their order.

•	 Send PDF versions of the exhibits to Editorial for review with the scope.

•	 Send HTML and PDF versions of the exhibits to Graphics when the scope is being finalized 
for posting.

ADDITIONAL FORMATTING

•	 Body text with indentation appropriate to the heading level it appears under may be 
specified using the style named Normal N, where N is the number of the heading level. In 
most cases, the proper style will be automatically chosen when you hit the Enter key at the 
end of the preceding heading.

•	 For bulleted or numbered lists, type your list using the Normal style. Highlight the text to 
be bulleted or numbered, then click on either a Bullet or Numbering button located in the 
Paragraph group on the Ribbon under the Home tab.

•	 For sub-bullets, highlight the appropriate text and hit the adjacent Increase Indent button. 
Repeat the process for further indented bullets. The Decrease Indent button will shift the 
text back a layer.

•	 For any point(s) in a bulleted or numbered list that is only one line take these steps:

	º Go to the Vertical Line Spacing in the Paragraph group

	º Click on the button and select Remove Space After Paragraph 

•	 Do not change the indentation of the first item in a bulleted or numbered list because this 
will change the outline level associated with the list and result in confusion when readers 
use software to read the document aloud.  

Line and Paragraph Spacing
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IF YOUR PROJECT IS RELATED TO ANOTHER PROJECT

•	 If your work plan/program closely relates to another project or series of projects, you 
should (to the extent applicable) use the same basic tasks, list the tasks in the same order, 
and describe them in the same way.

•	 Refer to other projects by name and the date of their work plan or work program (do not 
cite the CTPS project number). 

PREPARATION FOR EDITING AND POSTING

•	 Make sure that Track Changes is always ON during the editing process of your draft. 
Editorial will turn off Track Changes when your document is finalized.

•	 Send your document to Graphics to be converted into a PDF. Be sure to include both PDF 
and HTML versions of the exhibits.

•	 For MPO meeting materials, Graphics will notify you and a member of MPO Activities of 
the location of the final document. A member of MPO Activities will post the document to 
the meeting calendar.

•	 For all other website postings, Graphics will notify you directly. You should consult with 
the Deputy Executive Director and Data Management about posting the document. Data 
Management will post the document once it has been approved for posting.

 



22  |  Document Production Guidebook

NOTES



MEMOS
Starting Out

Additional Formatting

Formatting Tables and Figures

Adapting Your Memo for General Correspondence

Preparation for Editing and Posting
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Civil Rights, nondiscrimination, and accessibility information is on the last page. 

 
 

TECHNICAL MEMORANDUM 
 
DATE: [Month Day, Year] [Use To/From style] 
TO: [MassDOT] 
FROM: [Insert author(s) name(s)] 
RE: [Insert Title Here, with Title Style Caps as in This Sentence.] Title 

should not exceed one line. 
 
[Type a summary of your memo in this space, if you wish. Do not use the “RE” 
line above for that purpose. If you do not use this space for a description, delete 
this example text and begin your text under Heading 1. Delete the brackets as 
you replace all text.] 
 

1 [STYLE: HEADING 1 WITHOUT BRACKETS] 
[Begin writing your document here.] 
 

1.1 [Style: Heading 2] 
[Continue writing your document here.] 
 
[Style: Heading 3] 
[Continue writing your document here.] 
 
[Style: Heading 4] 
[Continue writing your document here.] 
 

1.2 [Style: Heading 2] 
[Continue writing your document here.] 
 

2 [STYLE: HEADING 1] 
[Continue writing your document here.] 
 

2.1 [Style: Heading 2] 
[Continue writing your document here.] 
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If you need help using the template or have any questions, please see someone 
in the Editorial or Graphics group. 

Remember to apply styles throughout your document. Refer to the  
Getting to Know the Process section of this guidebook to make sure that you 

are applying them correctly.

STARTING OUT

•	 Download the Technical Memo Template from our intranet site (https://intranet.ctps.org/
templates-home) to ensure that you are working with the most up-to-date template. 
Rename your document according to the CTPS file-naming protocol. (See How Should I 
Name My Document? on page 10.)

•	 Change “CTPS Technical Memo” found in the Title field of the document Properties to the 
current title of your document and the current date. To access the Title field, click the File 
tab at the top of your Word document and select Info in the left navigation. The Title field 
is to the right under the image of the document and the Properties header. To change the 
text, click in the field and replace the existing text with your new information.

•	 Replace all text within the brackets, including the brackets themselves, with the 
appropriate text. 

•	 Remember to add your memo’s title and the memo’s date in the header of the second 
page. Page numbers in the footer are generated automatically. Graphics and Editorial will 
take care of any additional formatting, if necessary.

•	 The title of your memo on the RE line must be one line only. 

ADDITIONAL FORMATTING

•	 For top level content (i.e., Date, To, From, and Re:), use the To/From style.

•	 Heading 1 and Heading 2 are preceded by section and subsection numbering, 
respectively. Heading 3 and Heading 4 are not.

•	 Headings 5 and 6 are available in the style list, but we discourage using them in memos. 
Please see Editorial if you think you need them.

•	 You may insert Page Breaks if you need them. Do not use Section Breaks.

•	 To insert a footnote, use the Insert Footnote button under the References tab on the 
Ribbon. Be sure to apply Footnote Text style to your footnote text. 

https://intranet.ctps.org/templates-home
https://intranet.ctps.org/templates-home
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•	 For any point(s) in a bulleted or numbered list that runs longer than one line, follow these 
steps:

	º Go to the Layout tab on the Ribbon; 

	º Then go to the Paragraph group in the center;

	º Select all bullets except for the final one in the list; and

	º Adjust the After spacing to 6pt. 

Layout Tab

Change to 
6pt
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FORMATTING FIGURES AND TABLES

Please consult the Tables and Figures section of this guidebook on page 65 for complete details 
about how to properly format tables.

•	 Generate tables in Excel, then insert them into the document using the instructions in the 
Tables section of this guidebook.

•	 Use the Figure/Table Title style on the titles of figures and tables. The figure or table 
number should be on the first line in sentence caps, then the title on the second line. Use 
soft returns (Shift + Enter) when adding new lines to maintain the formatting. See below 
for an example: 

Table 1 [Shift+Enter]
This is the Title of the Table 

•	 To create and maintain automatic table and figure numbering, copy the figure or table 
number and title lines from the template and paste them before each new table or figure 
that you add. Numbers will not update until you view the document in print preview. 
Use a soft return [Shift + Enter] after the table title and number to ensure style remains 
consistent. Like the Table of Contents, table/figure numbers use Quick Parts Field Code, 
which will allow the user to create an automated numbering system. In order for this to 
work correctly, the field command must be a part of the text, which is why copying and 
pasting from the original template table/figure title header (i.e., Table X or Figure X) is 
important.

•	 If tables or figures (such as maps or photos) are to be a full page or in a landscape 
style, create a placeholder page instead of inserting them into the Word document. 
To create a placeholder page, add a blank page where the table(s) or graphic(s) will be 
inserted. Do not use section breaks. On this placeholder page, write the title/name of the 
accompanying file for the page. Graphics will insert the table(s) or graphic(s) in the PDF 
when they prepare it for posting.

•	 ALT-Text must accompany each figure and table. (See What is ALT-text and Why Do I Need It? 
on page 16 for guidance.) Please see Editorial if you would like to have a sample of ALT-
Text.

•	 Citation information that includes a source must accompany every table or figure 
(unless it is the author’s own work that was completed for the memo or report). Source 
information should be included for tables or figures from other CTPS documents. 

	º Use the Figure/Table Citation style for this text. Please see the Tables section of this 
guidebook for further guidance about proper formatting. See the example below:

[Notes, if any.]
[Caption footnotes, if any.]
[Acronyms and abbreviations, if any.]
[Source(s): ___.] 
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	º All acronyms and abbreviations used in the table must be defined alphabetically 
along one line separated by periods (e.g., CTPS = Central Transportation Planning 
Staff. MAPC = Metropolitan Area Planning Council. MPO = Metropolitan Planning 
Organization). 

ADAPTING YOUR MEMO FOR GENERAL CORRESPONDENCE 

•	 If you wish to write a short memo for the purposes of general communication, follow the 
instructions for the Technical Memo with the following adjustments:

	º In the document title, delete the word “TECHNICAL” from before “MEMORANDUM.”

	º On the last page, in the lower left-hand corner, please indicate if you are copying 
anyone. If so, add carbon copy (cc) lines, as shown in the example below:

cc:	 R. Smith, Massport [Shift+Enter]
J. Jones, MBTA

◊	 Use the shortened form or acronym of any organization name, if available. 
If the copied recipient has no affiliation, delete the comma following the 
name.

◊	 Use soft returns (Shift + Enter) when adding new lines to maintain the 
formatting or hit Tab on subsequent lines for alignment.

◊	 If you are not copying anyone, delete the cc: lines from the template.

•	 If your memo has appendices, attachments, or enclosures, indicate so on the last page, in 
the lower left-hand corner or after the cc: lines. 

	º At the beginning of the memo briefly describe each enclosure; explain why it is 
included, and, if necessary, how the reader should use it. 

	º Use “Enclosure” for only one and “Enclosures (N)” for multiple enclosures, where N is 
the number of items enclosed.

	º If you do not have appendices or enclosures, delete the enclosure line from the 
template. 

PREPARATION FOR EDITING AND POSTING

•	 Make sure that Track Changes is always turned on during the editing process of your draft. 
If applicable, Editorial will create a client review draft before finalizing the document. Once 
any changes have been incorporated, Editorial will turn off Track Changes and remove the 
watermark when your document is finalized.

•	 Submit all ALT-Text to Editorial in a separate document either with your document or as 
soon as possible after submitting. If you need assistance, ask Editorial.
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•	 For MPO meeting materials, Graphics will notify you and a member of MPO Activities of 
the location of the final document. A member of MPO Activities will post the document to 
the meeting calendar.

•	 For all other website postings, Graphics will notify you directly. Refer to the instructions on 
the intranet regarding web postings.

https://intranet.ctps.org/website-content-requests
https://intranet.ctps.org/website-content-requests
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• This page is a reminder to create a cover for your report. 

• Schedule a time to discuss a cover design with Graphics. 
Provide sufficient time for production. 

• If you are using this template for a document other than a 
standard report, such as a guidebook or a StoryMap, please 
talk to Editorial and Graphics about which sections of the 
template can be deleted. 

• Before beginning to work on your report, delete these bullets 
and the page break below, which will make the title page 
(currently page 2) the first page of your document. 

  



Document Production Guidebook  |  33

RE
PO

RT
S

If you need help using the template or have any questions, please see someone 
in the Editorial or Graphics group.

Remember to apply styles throughout your document. Refer to the  
Getting to Know the Process section of this guidebook to make sure that you 

are applying them correctly.

To create a custom document, one that does not follow the look of a standard 
report template, you should have already met with managers of Editorial and 
the Graphics team. Documents that are different from the template require 

additional time to develop. 

STARTING OUT

Download the report template from our intranet site (https://intranet.ctps.org/templates-home) 
to ensure that you are working with the most up-to-date template. Rename your document 
according to the CTPS file-naming protocol. (See How Should I Name My Document? on page 10.) 
Page numbers in the footer are applied automatically. 

Cover

When you begin your report, schedule a time to meet with Graphics to discuss a cover that they 
will prepare for your report.

Page 1—Title Page

•	 Replace all text within the brackets, including the brackets themselves, with the 
appropriate text. If you are unsure which agency or contract numbers to place on this 
page, ask your group manager.

•	 Keep your report title short. If you need to, you may make the subtitle longer and more 
descriptive.

•	 After you delete the first page (the placeholder for the cover), this will become Page 1, but 
numbering won’t appear until Page 2 (numbering for the first page is invisible).

•	 Add your report’s title and the report’s date in the header.

Page 2—Map Page

When you meet with Graphics about the cover, also ask them to create a map pertinent to 
your project. You should meet with Graphics when you begin your report to provide them with 
sufficient time to create both the map and the cover.

https://intranet.ctps.org/templates-home
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Page 3—Nondiscrimination Page

Use the text provided in the template.

Page 4—Abstract

The abstract is a short, stand-alone summary of your report. An abstract should clearly and briefly 
identify the purpose, problem, methods, results (if any), and a conclusion. Your abstract will be 
used as the summary text that accompanies your report on the website.

Page 5—Table of Contents

You are not responsible for creating the table of contents. Editorial will manage and update 
this page for you at the end of the editing process. Appendices, though listed here, should be 
generated and compiled in a separate document.

Page 6—Executive Summary

The executive summary should provide a clear and concise (generally not more than a few pages) 
overview of what the report is about and why it was done, what is most important or unique 
about the report, and the report’s primary findings and recommendations.

FORMATTING THE MAIN DOCUMENT

•	 New chapters always begin on a new page, and on an odd page. Insert a Page Break at the 
end of each chapter (never use Section Breaks.)

•	 Formatting of table of contents, chapters, and pagination will be handled during the final 
round of editing.

•	 Heading 1 and Heading 2 are preceded by section and subsection numbering, 
respectively. The remaining five headings are not.

•	 Numbering within the Report will follow the chapter number. For example, a subsection 
within Chapter 1 will be 1.1. Any further subsections will add another number (for 
example, 1.1.1). The first number will ALWAYS be the same as the chapter number, and the 
second number will be the subsection number.

•	 For purposes of organization and HTML conversion, use as few heading levels as possible.

•	 You may insert Page Breaks if you need them. Do not use Section Breaks.

•	 To insert a footnote, use the Insert Footnote button under the References tab on the 
Ribbon. Be sure to apply Footnote Text style for your footnote text. 
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•	 For any point(s) in a bulleted or numbered list that runs longer than one line, take these 
steps:

	º Go to the Layout tab on the Ribbon; 

	º Then go to the Paragraph group in the center;

	º Select all bullets except for the final one in the list; and 

	º Adjust the After spacing to 6pt. 

Please see the Editorial group if you have any questions.

Layout Tab

Change to 
6pt
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FORMATTING FIGURES AND TABLES

Please consult the Tables and Figures section of this guidebook on page 65 for complete details 
about proper formatting. 

•	 Generate ALL tables in Excel, then insert them into the document using the instructions in 
the Tables section of this guidebook.

•	 Use the Figure/Table Title style on the titles of figures and tables. The figure or table 
number should be on the first line in sentence caps, then the title on the second line. Use 
soft returns (Shift + Enter) when adding new lines to maintain the formatting. See below 
for an example: 

Table 1 [Shift+Enter]
This is the Title of the Table

•	 To create and maintain automatic table and figure numbering, copy the figure or table 
number and title lines from the template and paste them before each new table or figure 
that you add. Numbers will not update until you view the print preview. Use a soft return 
[Shift + Enter] after Table and number to ensure style remains consistent. Like Table of 
Contents, table/figure numbers use Quick Parts Field Code, which will allow the user 
to create an automated numbering system. In order for this to work correctly, the field 
command must be a part of the text, which is why copying and pasting from the original 
template table/figure title header (i.e., Table X or Figure X) is important.

•	 If tables or figures (such as maps or photos) are full page, create a placeholder page 
instead of inserting them into the Word document. To create a placeholder page, add a 
blank page where the table(s) or graphic(s) will be inserted. DO NOT use section breaks. 
On this placeholder page, write the title/name of the accompanying file for the page. 
Graphics will insert the table(s) or graphic(s) in the PDF when they prepare it for posting.

•	 ALT-Text must accompany each figure and table. (See What is ALT-text and Why Do I Need It? 
on page 16 for guidance.) Please see Editorial if you would like to have a sample of ALT-
Text.

•	 Citation information that includes a source must accompany every table (unless the table 
is the author’s own work that was done for the report). Source information should be 
included for tables from other CTPS documents. 

	º Use the Figure/Table Citation style for this text. Please see the Tables section of this 
guidebook for further guidance about proper formatting. See the example below:

[Notes, if any.]
[Caption footnotes, if any.]
[Acronyms and abbreviations, if any.]
[Source(s): ___.]

	º All acronyms and abbreviations used in the table must be defined alphabetically 
along one line separated by periods (e.g., CTPS = Central Transportation Planning 
Staff. MAPC = Metropolitan Area Planning Council. MPO = Metropolitan Planning 
Organization.) 
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CONVERTING A MEMO INTO A REPORT

If you began writing a memo and later decided to convert it to a report, simply cut and paste the 
text into the report template. Keep a few things in mind, however:

•	 Section headers will be promoted one number when you switch from memo to report. 
You will need to reformat all Heading 1 headers into Chapter headings in the report. 
Heading 2 will become Heading 1 in the report, and so forth.

•	 All chapter headings should include “Chapter,” the chapter number, and the title (for 
example, “Chapter 1—Shared-Use Mobility”).

•	 Numbering within the report will follow the chapter number. For example, subsections 
within Chapter 2 will be numbered 2.1, 2.2, 2.3, and so on. Further subsections will 
follow the subsection number. For example, under subsection 2.1, the sections would be 
numbered 2.1.1., 2.1.2, 2.1.3, and so on. 

PREPARATION FOR EDITING AND POSTING

•	 Make sure that Track Changes is always turned on during the editing process of your draft. 
If applicable, Editorial will create a client review draft before finalizing the document. 
Once any changes have been incorporated, Editorial will turn off Track Changes when your 
document is finalized.

•	 Submit all ALT-Text to Editorial in a separate document either with your document or as 
soon as possible after submitting. If you need assistance, ask Editorial.

•	 For MPO meeting materials, Graphics will notify you and MPO Activities of the location of 
the final document. MPO Activities will post the document. For all other website postings, 
Graphics will notify you directly. Refer to the instructions on the intranet regarding web 
postings.

https://intranet.ctps.org/website-content-requests
https://intranet.ctps.org/website-content-requests
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Title 

Subtitle 

Project Manager 
[Name] 
 
Project Principal 
[Name] 
 
Data Analysts 
[Name] 
 
Graphics 
[Graphics Contributor] 
 
Cover Design 
[Cover Designer] 
 
Editorial 
[Cover Designer] 
 
Contributors 
[Cover Designer] 
 
 
The preparation of this document was supported  
by [place name of agency here] through  
[place contract numbers here]. 
 
Central Transportation Planning Staff is 
directed by the Boston Region Metropolitan 
Planning Organization (MPO). The MPO is composed of 
state and regional agencies and authorities, and  
local governments. 
 
 
[Month Year] 
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If you need help using the template or have any questions, please see someone 
in the Editorial or Graphics group.

Remember to apply styles throughout your document. Refer to the  
Getting to Know the Process section of this guidebook to make sure that you 

are applying them correctly.

To create a custom document, one that does not follow the look of a briefings 
template, you should have already met with managers of Editorial and the 
Graphics team. Documents that are different from the template require 

additional time and budget to develop. 

STARTING OUT

Download the briefings template from our intranet site (https://intranet.ctps.org/templates-
home) to ensure that you are working with the most up-to-date template. Rename your 
document according to the CTPS file-naming protocol. (See How Should I Name My Document? 
on page 10.) Page numbers in the footer are applied automatically. Graphics and Editorial will 
take care of any additional formatting, if necessary.

Cover

When you begin your briefings, schedule a time to meet with Graphics to discuss a cover that 
they will prepare for your briefings.

Page 1—Title Page

•	 Replace all text within the brackets, including the brackets themselves, with the 
appropriate text. If you are unsure which agency or contract numbers to place on this 
page, ask your group manager.

•	 Keep your briefings title short. If you need to, you may make the subtitle longer and more 
descriptive.

•	 After you delete the first page (the placeholder for the cover), this will become Page 1, but 
numbering won’t appear until Page 2 (numbering for the first page is invisible).

•	 Add your briefing’s title and the briefing’s date in the header.

Page 2—Table of Contents

You are not responsible for creating the table of contents. Editorial will manage and update 
this page for you at the end of the editing process. Appendices, though listed here, should be 
generated and compiled in a separate document.

https://intranet.ctps.org/templates-home
https://intranet.ctps.org/templates-home
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Last page—Nondiscrimination Page

Use the text provided in the template.

FORMATTING THE MAIN DOCUMENT

•	 Formatting of table of contents, and pagination will be handled during the final round of 
editing.

•	 Heading 1 and Heading 2 are preceded by section and subsection numbering, 
respectively. The remaining five headings are not.

•	 Numbering within the Briefing will follow the section number. For example, a subsection 
within Section 1 will be 1.1. Any further subsections will add another number (for 
example, 1.1.1). The first number will ALWAYS be the same as the section number, and the 
second number will be the subsection number.

•	 For purposes of organization and HTML conversion, use as few heading levels as possible.

•	 You may insert Page Breaks if you need them. Do not use Section Breaks.

•	 To insert a footnote, use the Insert Footnote button under the References tab on the 
Ribbon. Be sure to apply Footnote Text style for your footnote text. 

•	 For any point(s) in a bulleted or numbered list that runs longer than one line, take these 
steps:

	º Go to the Layout tab on the Ribbon; 

	º Then go to the Paragraph group in the center;

	º Select all bullets except for the final one in the list; and 

	º Adjust the After spacing to 6pt. 

Please see the Editorial group if you have any questions.
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FORMATTING FIGURES AND TABLES

Please consult the Tables and Figures section of this guidebook on page 65 for complete details 
about proper formatting. 

•	 Generate ALL tables in Excel, then insert them into the document using the instructions in 
the Tables section of this guidebook.

•	 Use the Figure/Table Title style on the titles of figures and tables. The figure or table 
number should be on the first line in sentence caps, then the title on the second line. Use 
soft returns (Shift + Enter) when adding new lines to maintain the formatting. See below 
for an example: 

Table 1 [Shift+Enter]
This is the Title of the Table

•	 To create and maintain automatic table and figure numbering, copy the figure or table 
number and title lines from the template and paste them before each new table or figure 
that you add. Numbers will not update until you view the print preview. Use a soft return 
[Shift + Enter] after Table and number to ensure style remains consistent. Like Table of 
Contents, table/figure numbers use Quick Parts Field Code, which will allow the user 
to create an automated numbering system. In order for this to work correctly, the field 
command must be a part of the text, which is why copying and pasting from the original 
template table/figure title header (i.e., Table X or Figure X) is important.

Layout Tab

Change to 
6pt
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•	 If tables or figures (such as maps or photos) are full page, create a placeholder page 
instead of inserting them into the Word document. To create a placeholder page, add a 
blank page where the table(s) or graphic(s) will be inserted. DO NOT use section breaks. 
On this placeholder page, write the title/name of the accompanying file for the page. 
Graphics will insert the table(s) or graphic(s) in the PDF when they prepare it for posting.

•	 ALT-Text must accompany each figure and table. (See What is ALT-text and Why Do I Need 
It? on page 16 for guidance.) Please see Editorial if you would like to have a sample of ALT-
Text.

•	 Citation information that includes a source must accompany every table (unless the table 
is the author’s own work that was done for the report). Source information should be 
included for tables from other CTPS documents. 

	º Use the Figure/Table Citation style for this text. Please see the Tables section of this 
guidebook for further guidance about proper formatting. See the example below:

[Notes, if any.]
[Caption footnotes, if any.]
[Acronyms and abbreviations, if any.]
[Source(s): ___.]

	º All acronyms and abbreviations used in the table must be defined alphabetically 
along one line separated by periods (e.g., CTPS = Central Transportation Planning 
Staff. MAPC = Metropolitan Area Planning Council. MPO = Metropolitan Planning 
Organization.) 

PREPARATION FOR EDITING AND POSTING

•	 Make sure that Track Changes is always turn on during the editing process of your draft. If 
applicable, Editorial will create a client review draft before finalizing the document. Once 
any changes have been incorporated, Editorial will turn off Track Changes when your 
document is finalized.

•	 Submit all ALT-Text to Editorial in a separate document either with your document or as 
soon as possible after submitting. If you need assistance, ask Editorial.

•	 For MPO meeting materials, Graphics will notify you and MPO Activities of the location of 
the final document. MPO Activities will post the document. For all other website postings, 
Graphics will notify you directly. Refer to the instructions on the intranet regarding web 
postings.

https://intranet.ctps.org/website-content-requests
https://intranet.ctps.org/website-content-requests
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NOTE: If you require any accommodations in order to participate or experience 
technical difficulties during the meeting, please contact [INSERT NAME], MPO 

Staff, at [email@ctps.org] or [XXX.XXX.XXXX]. 

Agenda posted before [H:MM AM/PM], [Month Day, Year]  

Metropolitan Planning Organization Meeting 

Transportation Board Room, 2nd Floor, 10 Park Plaza, Boston, MA 
[Meeting Date Month Day, Year], [Meeting Time H:MM AM/PM] (Estimated duration: 

[#] hours and [#] minutes, expected ending at [H:MM AM/PM]) 

Please note: [This note may be omitted if unnecessary.] This meeting will be 
[followed by] [preceded by] a [Unified Planning Work Program 
Committee] [Congestion Management Process Committee] meeting 
beginning at approximately [H:MM AM/PM]. 

Zoom Video Conferencing Platform: [Insert zoom link with hyperlink here] 

To connect via phone, dial one of the toll-free phone numbers 877.853.5257 or 
888.475.4499; follow the prompts to enter the meeting ID. The Meeting ID is [Enter 
number here. It will be the same number as the digits at the end of the URL]. 

Meeting Agenda 

1. Introductions, 5 minutes    

2. Chair’s Report, 5 minutes  

3. Executive Director’s Report, 5 minutes    

4. Public Comments, 10 minutes    

5. Committee Chairs’ Reports, 5 minutes 

6. Community Advisory Council Report, 5 minutes 

7. Action Item: Approval of [Month Day, Year], Meeting Minutes, [(posted) or (to 
be posted)] 

8. [Item,] [Presenter, Title:] [Brief description…], [#] minutes [(posted) or (to be 
posted)] 

9. [Item,] [Presenter, Title:] [Brief description…], [#] minutes [(posted) or (to be 
posted)] 

Civil Rights, nondiscrimination, and accessibility information is on page 3. 
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If you need help using the template or have any questions, please see someone 
in the Editorial or Graphics group.

Remember to apply styles throughout your document. Refer to the  
Getting to Know the Process section of this guidebook to make sure that you 

are applying them correctly.

Editorial can make changes to the Agenda template based on committee 
requests. Please reach out to Editorial if you have any changes that need to be 

made to your particular committee agenda. 

STARTING OUT

•	 Download the appropriate meeting agenda template from our intranet site 
(https://intranet.ctps.org/templates-home) to ensure that you are working with the most 
up-to-date template. Rename your document according to the CTPS file-naming protocol. 
(See How Should I Name My Document? on page 10.)

•	 Replace all text enclosed in square brackets, including the brackets themselves, with 
appropriate text, as directed by the text in brackets.

•	 Although the meeting agenda items may be changed in numbers 1 through 6, they are 
typical to all agenda so they are provided in the template as real text. Delete or change 
the items as necessary.

•	 Use the exact format and wording shown in the template agenda whenever possible.

•	 For consistency, do not change the template except if absolutely necessary to make it 
work for your meeting. It should never be necessary to change the main headings: do not 
add or delete headings, reword them, or change their order.

•	 When creating the PDF, insert the MPO letterhead watermark. 

•	 If you need hard copies to hand out, print as a two-sided document.  

https://intranet.ctps.org/templates-home
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CREATING YOUR AGENDA

•	 Replace the location as necessary; make sure you list the correct conference rooms.

•	 You must include a time estimate with each agenda item.

•	 All agenda items following the Executive Director’s Report (beginning with item 7) must 
be attributed to a person, with the person’s title following. Select the person’s name and 
title and apply the Agendum Presenter style. Select any descriptive text following the 
agenda heading and apply the Agendum Description style.

•	 If any of your agenda items focus on a document, you must indicate in the description 
whether or not the document has been posted on the website or is to be posted in the 
future.

•	 If any items on the agenda will be action items requiring a vote by the board or 
committee, list the topic under the header “Action Item.”

•	 Meeting Minutes and Members’ Items both appear in the template. These are regular 
items on the MPO meeting agenda and appear as they will be listed. If these items are not 
relevant to your meeting, you may delete them. Change any other text on the template as 
necessary for your agenda.

•	 Do not delete the blank line at the end of the agenda template. This line anchors the 
disclaimer information that appears at the bottom of the page.

•	 For bulleted lists, use the Bullet button under the Home tab on the Ribbon. You will need 
to remove space between the items in the list. Follow the directions below to remove the 
space:

	º Select your bulleted text

	º Go to the Vertical Line Spacing  
in the Paragraph group

	º To remove space, click on the  
button and select  
Remove Space After Paragraph 
 

 
 

Select
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Choose the Numbered style for numbered lists. These lists are multi-level lists, which mean that 
if you increase the indentation (hit the Tab key at the start of the line); the numbered style will 
change accordingly to help differentiate the levels.

 
PREPARATION FOR EDITING AND POSTING

•	 Make sure that Track Changes is always turned on during the editing process of your draft. 
If applicable, Editorial will create a client review draft before finalizing the document. Once 
any changes have been incorporated, Editorial will turn off Track Changes and watermark 
when your document is finalized.

•	 In some cases, MPO Activities can create their own HTML and PDF of agendas and post 
them to the calendar. In such cases, to create the most standards-compliant HTML, Word 
documents should be saved as type “Web Page, filtered” with the encoding set to “Unicode 
(UTF-8)” (look under the “Web options...” choice of the Tools menu in the “Save As” dialog 
window).

AGENDA TYPES ON THE MEETING AGENDA TEMPLATES PAGE

•	 MPO

•	 UPWP

•	 TIP Process, Engagement, and Readiness Committee

•	 Advisory Council
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MEETING MINUTES
Starting Out

Creating Your Meeting Minutes

Preparation for Editing and Posting
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MPO Meeting Minutes 
Draft Memorandum for the Record 
Boston Region Metropolitan Planning Organization Meeting 

[Month Day, Year], Meeting 
10:00 AM–[H:MM AM/PM], Zoom Video Conferencing Platform 

[David Mohler or Steve Woelfel], Chair, representing Monica Tibbits-Nutt, Secretary of 
Transportation and Chief Executive Officer of the Massachusetts Department of 
Transportation (MassDOT) 

Decisions 

The Boston Region Metropolitan Planning Organization (MPO) agreed to the following:  

• [Insert text here] Example: Approve the minutes of the meeting of [Month Day, 
Year] 

• [Insert text here] Example: Approve the work program for… 

Meeting Agenda 

1. Introductions 
See attendance on page [#]. 

2. Chair’s Report—David Mohler, MassDOT 
[Insert text here]  

3. Executive Director’s Report—Tegin Teich, Executive Director, 
Central Transportation Planning Staff 

[Insert text here] 

4. Public Comments    
[Insert text here] 

5. Committee Chairs’ Reports  
[Insert text here] 

6. Community Advisory Council Report—[Name], Chair, Community 
Advisory Council 

[Insert text here] 
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If you need help using the template or have any questions, please see someone 
in the Editorial or Graphics group.

Remember to apply styles throughout your document. Refer to the  
Getting to Know the Process section of this guidebook to make sure that you 

are applying them correctly.

STARTING OUT

•	 Download the meeting minutes template from our intranet site (https://intranet.ctps.
org/templates-home) to ensure that you are working with the most up-to-date template. 
Rename your document according to the CTPS file-naming protocol. (See How Should I 
Name My Document? on page 10.)

•	 Replace all text enclosed in square brackets, including the brackets themselves, with 
appropriate text.

•	 Use the exact format and wording shown in the minutes template whenever possible. 

•	 For consistency, don’t change the template except if absolutely necessary to make it work 
for your minutes. Never change the main headings: don’t add or delete any, reword them, 
or change the order.

•	 Do not change the font used in the template, which is Arial for the body text and 
Trebuchet for the headings. Point size varies within the meeting minutes template and 
should not be changed.

•	 Change “Meeting Minutes” found in the Title field of the document Properties to the 
current title of your document and the current meeting date. To access the Title field, click 
the File tab at the top of your Word document and select Info in the left navigation. The 
Title field is to the right under the image of the document and the Properties header. To 
change the text, click in the field and replace the existing text with your new information. 

CREATING YOUR MEETING MINUTES

•	 In the [Month Day, Year] brackets, enter the date of the meeting and delete the brackets. 

•	 Add the date in the header at the top of the second page.

•	 Change the start and end time as appropriate.

•	 Make sure the entire location is correct, including the building, room, and address. If the 
meeting took place virtually, please state that instead.

•	 Below the date, fill in the name of the presiding chairperson. 

•	 Under Decisions, list the decisions or vote outcomes from the meeting. The names of any 
work scopes should be in italics.

https://intranet.ctps.org/templates-home
https://intranet.ctps.org/templates-home
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•	 The Heading 2 style, which provides automatic numbering, should be used for each 
agenda item.

•	 Some of the items on the template under the Meeting Agenda heading are typical 
components of the MPO meeting minutes. Delete any that are not relevant to your 
particular meeting. 

•	 For the Chair’s Report and the Committee Chairs’ Reports, insert report information as 
appropriate. If no information was reported, write “There was none” under the Chair’s 
Report header and “There were none” under the Committee Chairs’ Reports header.

•	 Following the reports, use items from the original agenda (minus the time estimate) as 
heading text. The subject matter appears first, followed by an em dash (type two hyphens 
and the next word (no spaces), and Word will substitute an em dash automatically), then 
the presenter, title, and organization. Apply the Meeting Presenter style to the presenter, 
title, and organization.

•	 You should use subheads to break up agenda items that contain a lot of text.  Use the 
Heading 3 style for subheads within agenda items.

•	 If you need columns of text to present data, use a table to do so. See the instructions on 
creating a table below.

•	 If you need to create a table, go to the Insert tab and insert a table using the Table 
function dropdown. 

	º Under the Design tab in Table  Tools, select the first of the table designs from the 
Table Design ribbon. This is the CTPS Basic Table (it should be first of the table style 
illustrations—hover over it to view the name in the tool tip). 

	º Check the Total Row box in the Table Style Options group of the ribbon.

	º In the Table Layout ribbon, choose Properties. In the Table tab, choose Centered 
Alignment. In the Column tab, uncheck the Preferred width option for each 
column.

	º If your columns contain numbers, you may have to manually set those cells to be 
right justified.
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•	 For bulleted or numbered lists, use the Bullet or Number button under the Home tab 
on the Ribbon. You will need to remove space between the items in the list. Follow the 
directions below to remove the space:

	º Select all but the last item of your bulleted text

	º Go to the Vertical Line Spacing in the Paragraph group in the Home tab.

	º To remove space, click on the button and select Remove Space After Paragraph

•	 Under Adjourn, replace the information in brackets with the names and affiliations of the 
members who made and seconded the motion to adjourn.

•	 Attendees should be added at the end of the minutes; make sure to check the spelling 
and affiliations.

PREPARATION FOR EDITING AND POSTING

•	 Make sure that Track Changes is always on during the editing process of your draft. If 
applicable, Editorial will create a client review draft before finalizing the document. Once 
any changes have been incorporated, Editorial will turn off Track Changes and remove the 
watermark when finalized.

Select
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HEADING 1 
[Write text here] 
 
Heading 2 
[Write text here] 
 
Heading 3 
[Write text here] 
 
Heading 4 
[Write text here] 
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GENERAL PURPOSE
If you need help using the template or have any questions, please see someone 

in the Editorial or Graphics group.

Remember to apply styles throughout your document. Refer to the  
Getting to Know the Process section of this guidebook to make sure that you 

are applying them correctly.

STARTING OUT

Download the appropriate template from our CTPS intranet site (https://intranet.ctps.org/
templates-home) to ensure that you are working with the most up-to-date template. Rename 
your document according to the CTPS file-naming protocol. (See How Should I Name My 
Document? on page 10.)

Change “CTPS Document” found in the Title field of the document Properties to the current title 
of your document and the current date. To access the Title field, click the File tab at the top of 
your Word document and select Info in the left navigation. The Title field is to the right under 
the image of the document and the Properties header. To change the text, click in the field and 
replace the existing text with your new information.

WHAT IS THE GENERAL PURPOSE TEMPLATE FOR?

Occasionally, you may need to create a document that doesn’t fit any of the document templates. 
It is best always to use CTPS styles, even if your document may never need to be made accessible. 
By using the general purpose template, you can easily incorporate the text into any of the other 
CTPS templates in the future if the need arises. To use, simply write your document and apply the 
appropriate styles throughout. Ask Editorial if you are not sure of the correct template to use. 

DO I HAVE TO USE A TEMPLATE FOR EVERY DOCUMENT I CREATE?

Yes. You must download a new template every time you begin a new document. Downloading a 
new template ensures that you are working with the most up-to-date template and guarantees 
that screen-reading software will be able to follow the document. 

HOW DO I USE THE LARGE PRINT TEMPLATE?

To convert a document into large-print format, Copy and Paste the text into the Large Print 
template. If you applied the styles correctly, they will reformat to large text automatically.

https://intranet.ctps.org/templates-home
https://intranet.ctps.org/templates-home
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[Month Day, Year] 
 
 
[Mr./Ms./Dr./Honorable/etc.] [Recipient’s full name] 
[Position or Role], [Company or Organization] 
[Street Address] 
[City or Town], [State name (not abbreviation)]  [ZIP code] 
 
 
Re: [Subject with Caps as in This Example] 
 
 
Dear [Mr./Ms./Dr./Honorable/etc.] [Recipient’s last name]: 
 
[Write letter here. Style: Normal] 
 
[Continue letter here. Style: Normal] 
 
[Continue letter here. Style: Normal] 
 
[Continue letter here. Style: Normal] 
 
[Continue letter here. Style: Normal] 
 
Sincerely, 
 
 
 
[Your First Name] [Your Middle Initial] [Your Last Name] 
[Your Role or Position] 
[Your Group’s Name or the Agency Name] 
 
 
Enclosure [OR] Enclosures [N] 
 
 
cc: [First Initial] [Last Name], [Organization abbreviated][Shift+Enter] 

[First Initial] [Last Name], [Organization, abbreviated] 
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LETTERS
If you need help using the template or have any questions, please see someone 

in the Editorial or Graphics group.

Remember to apply styles throughout your document. Refer to the  
Getting to Know the Process section of this guidebook to make sure that you 

are applying them correctly.

USING THE LETTER TEMPLATE

•	 Download the letter template from our intranet site (https://intranet.ctps.org/templates-
home) to ensure that you are working with the most up-to-date template. Rename 
your document according to the CTPS file-naming protocol. (See How Should I Name My 
Document? on page 10.)

•	 Change “Letter” found in the Title field of the document Properties to the current title of 
your document and the current date. To access the Title field, click the File tab at the top 
of your Word document and select Info in the left navigation. The Title field is to the right 
under the image of the document and the Properties header. To change the text, click in 
the field and replace the existing text with your new information.

•	 Enter the date that the letter will be sent using the “month day, year” format.

•	 Enter the same date in the header of the second page.

•	 In one-page letters, add blank lines below the date so that the subsequent internal 
address is as far from the top of the page as the complimentary close (i.e., “sincerely” line) 
is from the bottom.

•	 Use the preferred honorific, such as “Mr.,” “Ms.,” “Dr.,” etc.; use Mx.

•	 Type the full name of the recipient of the letter. 

•	 Add the recipient’s name (without honorific) in the header of the second page.

•	 Add more lines if the street address requires them. Spell out the state name, i.e., 
Massachusetts rather than MA.

•	 If you want to include a subject line, use the RE line in the template. If not, delete this line 
and leave two blank lines between the address and the salutation line (i.e., “dear” line). 

https://intranet.ctps.org/templates-home
https://intranet.ctps.org/templates-home
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ENDING YOUR LETTER 

•	 If you are copying anyone, indicate so at the end of the letter, in the lower left-hand 
corner, after your signature, name, title, and organization.

•	 Add additional carbon copy (cc) lines, as necessary, as shown in the example below:

cc:	 R. Smith, Massport[shift+return] 
	 J. Jones, MBTA

	º Use the shortened form or acronym of any organization name, if available. If the 
copied recipient has no organization, delete the comma following the name.

	º Use soft returns (Shift + Enter) when adding new lines to maintain the formatting. 
Or: hit Tab on subsequent lines to put them in line with the one above it.

	º If you are not copying anyone, delete the cc: line from the template.

•	 If your letter has enclosures, indicate so below your signature, name, title, and 
organization (or cc: lines, if present). 

	º Type “Enclosure” for only one and “Enclosures (N)” for multiple enclosures, where N 
is the number of items enclosed.

	º At the beginning of the letter, briefly describe each enclosure and explain why it is 
included and how the reader should use it. 

	º If you do not have enclosures, delete the enclosure line from the template. 

PREPARATION FOR EDITING AND POSTING

•	 Make sure that Track Changes is always on during the editing process of your draft. 
Editorial will turn off Track Changes when your document is finalized.

•	 Graphics will add the letterhead and notify you of the location of the final document.
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JOB ADS
If you need help using the template or have any questions, please see someone 

in the Editorial or Graphics group.

Remember to apply styles throughout your document. Refer to the  
Getting to Know the Process section of this guidebook to make sure that you 

are applying them correctly.
 

USING THE JOB AD TEMPLATE

•	 Download the letter template from our intranet site (https://intranet.ctps.org/templates-
home) to ensure that you are working with the most up-to-date template. Rename 
your document according to the CTPS file-naming protocol. (See How Should I Name My 
Document? on page 10.)

•	 The job ad template is required for each new position to ensure that all job postings are 
consistent throughout the agency.

•	 Similar to our other products, job ads will need to go through the Editorial process before 
posting to the website.

•	 If you have any questions about information needed for completing the job ad, refer to 
Human Resources.

PREPARATION FOR EDITING AND POSTING

•	 Make sure that Track Changes is always turned on during the editing process of your draft. 
Editorial will turn off Track Changes when your document is finalized.

•	 A final version is sent to a member of the Human Resources team.

JO
B 

A
D

S

https://intranet.ctps.org/templates-home
https://intranet.ctps.org/templates-home
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TABLES AND FIGURES
Making Tables Accessible

Starting Out

Inserting the Table Into a Word Document from Excel

Formatting Tables

Simple Format Guide

Figure/Image Requirements

Copyright/Credit Information
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Tables for Work Plans and Programs, Reports, and Memos must be  
created in Excel. 

Alt-text will need to be provided for all tables and figures (for all public-facing 
documents) in a separate Word document. This should be sent to Editorial 

during the review process. You can find more information about creating alt-
text on page 16. If you need help creating or formatting tables, or have any 

questions, contact the Editorial or Graphics group.

MAKING TABLES ACCESSIBLE

Tables must be formatted using CTPS accessibility standards so that they can be fully described 
and navigated by a screen reader. Screen readers are applications that audibly read the material 
in an electronic voice to people who have difficulty reading from a computer monitor. Most 
people who use screen readers are blind or have low vision, but others may need to use them 
because of a learning or cognitive disability. 

Formatting tables for screen readers works best when you create the table in Excel; therefore, 
generate all tables for work plans and programs, reports, and memos in Excel. Once formatted, 
you can then insert them into your document. 

There are many ways of constructing tables, however, tables can be categorized broadly into two 
types: “simple” and “complex” tables.

•	 Simple Tables should be used whenever possible.

	º They present data in a completely uniform grid, with only one row of column heads 
(the top row in the table) and only one column of row heads (the first column in 
the table), with no merged cells or subsections.

•	 Complex Tables should be avoided whenever possible.

	º They have rows that are organized in multiple sections (each with a row section 
head) and/or multiple columns (each with a column head) grouped under one 
common column section head (in a merged cell).

STARTING OUT

•	 Do not merge cells. A screen reader cannot properly navigate a table that has merged 
cells.

•	 Avoid using complex tables whenever possible. If you need help converting your complex 
table into a simple table, see the Graphics group.
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•	 Data must be entered in ALL cells. For blank cells, type in “blank,” and match the color of 
the typeface to the color of the cell’s background. This way, it will visually appear blank, 
but still can be read by a screen reader.

•	 Do not insert extra empty rows or columns to add space. 

INSERTING THE TABLE INTO A WORD DOCUMENT FROM EXCEL

•	 Highlight and copy the table cells and paste them into Word using either the Use 
Destination Styles or Link and Use Destination Styles options in the Paste drop-down 
menu (the first icon on the Home tab on the Ribbon). Using either option allows you to 
change the table formatting in Word after the table has been inserted.

•	 Using either option allows you to change the table formatting in Word after the table has 
been inserted.

•	 Using the Link and Use Destination Styles option allows you to update the table data in 
Word automatically to reflect any changes you have made to the Excel table. To do so, 
right click anywhere in the Word table and click Update Link.

•	 If a table is to be a full page, create a placeholder page instead of inserting it into the Word 
document. To create a placeholder page, add a blank page where the table(s) or graphic(s) 
will be inserted. DO NOT use section breaks. On this placeholder page, write the title/
name of the accompanying file for the page. Graphics will insert the table(s) or graphic(s) 
in the PDF when they prepare it for posting.

•	 Use dashes not periods (ex Table A-3)

•	 If the table continues onto the next page, repeat the column headers at the top.

FORMATTING TABLES 

•	 After inserting the table into Word, format the table using the Simple Table Format Guide. 
See example on page 69.

•	 For a full-page table that will not be inserted into Word:

	º Format the table in Excel, using the Simple Table Format Guide. Create the table 
title in the Excel workbook page header: click the Header & Footer icon in the Text 
group of the Insert tab on the Ribbon, and type the table title.

	º Forward the file to Graphics to be added to the final document PDF.
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SIMPLE TABLE FORMAT GUIDE

An example of a horizontal table can be found in the Appendices section on page 81.

New Old
Parking Parking

Model Statistic Supply Supply
Daily transit mode split 47 44
Daily transit trips 8,000 75,000
Daily auto trips 375,000 375,000
Daily vehicle miles traveled
   on arterial roadways 275,600 275,600
Daily vehicle hours traveled blank 456,000
Daily parking demand 955 N/A
Unit operating cost per passenger $0.80 $1.65

Subtotal  579,500 579,500

Total 579,500 579,500

Table  1
Results of the Ridership Analysis of the Urban Ring Study

 Note: This table is not meant to make sense.
a 8,000 is bold
N/A = not applicable.
Source:  Data from Massachusetts Port Authority, Logan Five-Year Plan   
(2002), pp.121-27. 

SIMPLE TABLE: FORMAT GUIDE
Example of:
LANDSCAPE-ORIENTED 
(HORIZONTAL) TABLES

FONT AND POINT SIZE:
Arial 12 points

TOTAL

CITATION AREA

FOOTNOTES

COLUMN HEADS

ROW HEADS

TITLES/TABLE NUMBERS
3

a
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Acronyms/Abbreviations

•	 All acronyms and abbreviations used in a table should be defined below the table, on a 
separate line in the citation area.

•	 Arrange them alphabetically and separate them with periods. For example:  
FFY = federal fiscal year. mph = miles per hour. N/A = not applicable or available.

Alignment

Placement of table on page:

•	 Center tables horizontally on the page.

Column heads:

•	 Vertically align text in the column head at the bottom of the cell (whether or not the text 
in the column head wraps).

Columns of numbers, including column head:

•	 Right-align columns of numbers.

Columns of text, including column head:

•	 Left-align columns of text.

Columns of mixed text and numbers:

•	 Right-align columns of mixed text and numbers.

Row heads (far left column):

•	 Left-align text in row heads in the far left column.

•	 If the text is more than one line, use a hanging indent.

Rows:

•	 If only the row head has text on multiple lines, align cell contents at the bottom of the cell.

•	 If cells other than the row head have text on multiple lines, align cell contents at the top of 
the cell.

Vertically oriented text:

•	 Left-align text that is vertically oriented within a cell. 
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Bold Typeface

The following components should always be in bold type:  

•	 Column heads 

•	 Total rows

•	 Table titles

Bold text can also be used to emphasize the contents of a cell.

Borders

General:

•	 “Borders” are any lines in a table.

•	 Use the Borders function to create them.

•	 Never use underscore or underline functions.

Vertical borders:

•	 Try to avoid using vertical borders.

	º Vertical borders may be used to make a visual statement or separate columns of 
data that must appear very close together, or if they would help the reader grasp 
the organization of the table. 

Horizontal borders:

•	 Use horizontal borders only above and beneath column heads, above totals, at the bottom 
of a table, or to divide subsections.

•	 Use continuous borders, not partial borders.

Thickness of borders:

•	 In general, use default one-point lines for borders in Word, or the thinnest border option 
in Excel.

Capitalization

In column heads:

•	 Capitalize all major words (as you would see in the title of a book), but lowercase articles 
(the, a, and an), prepositions (up, down, on, to, etc.), and conjunctions (and, but, for, or, 
nor).

In row heads:

•	 Capitalize only the first letter of the first word.
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Citation Area

•	 Text in the citation area (the area below and on the outside of a table) should be two 
points smaller than the point size of the text in the table body. For example, if a table is 
displayed in Arial 12 point, then the footnotes, definitions, source, etc., should be in Arial 
10 point. Text should be no smaller than 8 point.

•	 Left-align citation text with hanging indents; do not skip any lines.

•	 The order of citations is as follows (each on its own line):

Note(s) (A “note” is a comment that applies to the entire table.)
aFootnotes (A “footnote” applies only to a specific element in a table.)
Acronyms (Multiple acronyms should be on one line.)
Source

Column Heads

•	 A column head contains text at the top of a column; it defines the data in the column.

•	 Column head text is bold.

•	 See Alignment above.

Column Widths

•	 Columns with the same category of data, for example, a group of columns all giving 
numbers of trips under various scenarios, should be of equal width.

•	 Columns with varying types of data do not have to be of equal width.

Consistency

•	 Format should be consistent within each table and from table to table within a document.

Empty Cells

•	 Empty cells are not audibly signaled by a screen reader, which can lead people using 
screen-reading software to lose their place in the table. Therefore, all cells must have 
something in them. 

•	 Write “blank” or use symbols or numbers formatted in the same color as the table 
background (usually white) in the “empty” cells. 

•	 For column and row heads, write “no heading.”

•	 For data cells, write a zero, N/A, or em dash (use the Special Character tab in the Insert 
Symbol dialog box).
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Font and Point Size

•	 Use Arial 12 point in the body of table and Arial 10 point in the citation area.

•	 Sometimes it may be necessary to use a smaller point size to fit the table on the page. In 
such cases, the largest possible font size should be used. If it appears that 8 point is too 
large, try using Arial Narrow before decreasing the point size any further. 

Footnotes

•	 Do not use MS Word’s footnote function to place footnotes under a table.

•	 Footnotes should appear immediately following the table, not in the table or at the 
bottom of the page.

•	 The Figure/Table Citation style in CTPS’s memo and report templates automatically 
provides the proper spacing. 

•	 Use an asterisk (*) if only one footnote is needed. 

•	 For an all-text table, use numbers as footnote symbols.

•	 For numerical or mixed (numbers and text) data, use lower case letters as footnote 
symbols.

•	 Make letters and/or numbers superscript both in the table and in the footnote.

•	 Footnotes within a table should read alphabetically or in numerical order, left to right.

•	 Avoid using symbols for footnotes (e.g., † ‡ §).

Hyphenation

•	 Do not use hyphens to split words in tables.

Landscape-Oriented (Horizontal) Tables

•	 When placing a landscape-oriented table in a document with mostly portrait-oriented 
pages, center the table on the page horizontally.

Not Applicable/Not Available

•	 Write “N/A,” not “na” or “NA,” to indicate “not applicable” or “not available.”

•	 Alternatively, you may put an em dash in the cell (use the Special Character tab in the 
Insert Symbol dialog box).

•	 If N/A is used, define this acronym in the citation area.
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Numbers

Commas:

•	 Use commas in numbers of 1,000 or greater (1,000 not 1000).

Decimals:

•	 Include leading zeros (0.68 not .68) and closing zeros (1.60 not 1.6) if rounding to two 
decimal places).

Negative Numbers:

•	 Use a negative sign rather than parentheses () to denote negative numbers.

Plural vs. Singular Wording

•	 Generally, you should use the singular form of words in the column heads (for example, 
“Model Statistic,” not “Model Statistics”).

Project Name

•	 The project name does not need to appear with the table unless the table will be 
distributed separately, such as in a meeting handout, in which case, the project name may 
be added in the header or footer.

•	 The project name should not be part of the table or table title.

Row Heads

•	 The leftmost column contains the titles of rows (“row heads”).

•	 The row head must contain information that defines the contents of a row.

•	 Capitalize only the first letter of the first word.

•	 A subtotal row head should indicate which values are included in the subtotal.

Shading

•	 Shading within cells or rows may be used with discretion.

•	 Use high-contrast shading so that text clearly stands out from the background.

•	 Shading of alternate rows is recommended on large tables that are one page or longer.

Spacing

•	 Do not add extra rows or columns to create spacing. 
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Spacing between columns:

•	 Avoid large gaps between columns.

•	 Space between columns should appear equal.

•	 Add more space between groups of columns within a table.

•	 There should be space between a cell’s contents, borders, and the content of adjacent 
cells.

•	 You may add space by indenting text. Use either the left or right horizontal alignment 
function.

Spacing between rows:

•	 Add a small amount of space above and below each horizontal border. In Excel, increase 
the row height and vertically align the cell contents at the top, center, or bottom of the cell 
to achieve the desired result.

Source

•	 The citation of source should begin with the word “Source” followed by a colon.

•	 The source should be the last item listed in the citation area.

Tables That Continue on Multiple Pages

•	 Do not split tables manually at the end of a page.

•	 Use the Repeat Header Rows table function, and allow them to split automatically.

Text Tables

•	 You may use a text table to organize text data in a document.

•	 Some of the rules of numerical data tables do not apply. For example, you may center 
columns of text if it is helpful in conveying the meaning of content.

•	 Usually, columns with text are left aligned.

Titles/Table Numbers

•	 Use Figure/Table Title style in the document template for table numbers and titles 

•	 Capitalize the title in sentence caps and center it above the table.

•	 Table numbers should be bold (for example, Table 3). 

•	 The table number should be followed by a soft return [Shift + Enter], so that it is on a 
separate line above the table title. 

•	 Title should be as short as possible. If the title does not fit on single line, the text should 
wrap (flow to the next line).
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Total

•	 Write “Total,” not “Totals.”

•	 The entire total row should be bold.

•	 Put a border above and below the total row.

•	 The entire subtotal row should be in italics.

Unit Signs

•	 Unit signs are symbols that refer to units of measure (for example, #, $, %, x, kg, mph).

•	 Do not repeat the same unit sign in every cell in a column unless more than one unit sign 
is used in the column.

•	 Do not use unit signs in column or row heads; rather, write the word (for example, 
“percent,” not “%”).

•	 All abbreviations and acronyms used in a table must be defined in the citation area below 
the table.

FIGURE/IMAGE REQUIREMENTS

Figures and images included in your report, memo, presentations should be of a high resolution 
and no smaller than 150 dpi. Graphics has an archive of high-quality images that can be used for 
your product. 

COPYRIGHT/CREDIT INFORMATION

To use a figure in your report, memo, or presentation, you must have permission to do so or own 
the image outright (personally or through CTPS). You cannot use an image from the internet in 
your report, memo, or presentation unless it is in the public domain. Contact the Graphics team 
if you are looking for a particular image as they may already have it in their archive. There are 
also transportation-related stock photos that can be used. However. if you are using an image 
from another source and you have permission to do so, you must provide credit information 
underneath the image or in the citation area.

A library of photos and icons can be found in the Graphics folder under Groups on the shared 
Google drive. You may also browse photos online at ShutterStock.com, or request an illustration 
from the Graphics team. To request an image you want from ShutterStock, please copy and paste 
the URL into an email and send it to Graphics@ctps.org. The Graphics Team will then download 
the photo and send it to the requestor.

If you have any questions about image copyright, public domain, or listing the credit information, 
contact Editorial.

http://ShutterStock.com
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AUTHOR GRAPHICS MPO ACTIVITIES

WORK SCOPE  
ACCESSIBLE-DOCUMENT PRODUCTION PROCESS

1 The agenda-setting meeting is generally held on the Monday of the week preceding the week of the MPO meeting. 
2 If Monday is a holiday, submit by the preceding Friday.

IF SCOPE MUST BE APPROVED BY MPO Action Completed 
No Later Than:

Monday2 of the week 
preceding the MPO 
meeting

When document is 
sent to Editing

Tuesday of the week 
preceding the MPO 
meeting

Tuesday-Wednesday 
of the week preceding 
the MPO meeting

Thursday of the week 
preceding the MPO 
meeting

By 5:00 PM on Thursday
of the week preceding 
the MPO meeting

Immediately after
posting

The draft scope is reviewed and approved by 
GROUP MANAGER, DIRECTORS/EXECUTIVE DIRECTORS, 

EDITORIAL GROUP, CLIENT.

REVIEW & 
APPROVAL

Author emails ALL Graphics staff (graphics@ctps.org) the
COMPLETED, APPROVED, AND EDITED SCOPE (in MS Word). 

EMAIL GRAPHICS
COMPLETED
SCOPE

Work scope approved for placement on MPO agenda at agenda-setting
meeting. (The week before the agenda-setting meeting,1 author should alert

the Executive Director and MPO Activities staff that they wish to have 
the scope on the agenda.) 

GET SCOPE 
ON MPO 
AGENDA

Author emails ALL Graphics staff that a work scope will be available soon.ALERT GRAPHICS

Graphics staff CREATES FINAL PDF (with letterhead) and HTML versions  
of scope and VERIFIES accessibility.

CREATE PDF & 
HTML DOC.

Graphics staff gives PDF and HTML versions to the author
 and NOTIFIES MPO Activities staff that scope is ready for posting on website.NOTIFY

MPO Activities staff PLACE PDF and HTML versions on website.
PLACE ON 
WEBSITE

MPO Activities staff emails a CONFIRMATION to author and 
Graphics that scope has been posted.

SEND
CONFIRMATION

Regardless of who makes a request for work to be undertaken, CTPS staff 
member notifies their group manager who directs the request to 

the Executive Director/Deputy Executive Director/Directors.

ROUTING OF
WORK
REQUEST

The Executive Director contacts OTP leadership to ensure that they are aware 
of the work request and agree that a scope should be written. 

REVIEW OF
REQUEST

After receiving go-ahead from Executive Director, author:
• Assembles project scoping team. 
• Convenes a meeting between Graphics, Editorial, Communications 

and Engagement, and other relevant groups to brainstorm about the 
presentation of the final product and potential outreach and 
promotion activities. 

• Writes Work Plan or Program using appropriate template found on 
the intranet.

• Creates scope exhibits using Exhibit Builder Tool on intranet. 
• Completes Project Support Budgets form and sends, along with scope, 

to Director of Finance and Operations.

WRITING 
OF
SCOPE

July 2025
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July 2025

The following process should be followed for all CTPS-produced documents (other than work scopes1) 
that will be posted for an MPO meeting or anywhere on the MPO website.

MEMO AND REPORT
ACCESSIBLE-DOCUMENT PRODUCTION PROCESS

  1 For work scopes, please refer to the “Work Scope Accessible-Document Production Process” flowchart. 
  2 The agenda-setting meeting is generally held on the Monday of the week preceding the week of the MPO meeting. 
  3 If Monday is a holiday, submit by the preceding Friday.

 4 For documents associated with MPO meetings, this refers to MPO Activities staff. For all other documents, this refers to 
   Information Technology staff.

DescriptionACTION Action Completed 
No Later Than:

Tuesday of the week 
preceding the MPO 
meeting

Author emails ALL Graphics staff (graphics@ctps.org) the 
COMPLETED, APPROVED, AND EDITED DOCUMENT (in MS Word), 

including any additional materials such as appendices, 
figures, maps, etc. 

SEND 
DOCUMENT
TO GRAPHICS

Document approved for placement on MPO agenda at 
agenda-setting meeting (if applicable). The week before the 

agenda-setting meeting, author should alert the MPO Activities 
staff that they wish to have the document on the agenda.2 

Monday 3 of the week 
preceding the MPO 
meeting 

GET DOCUMENT 
ON MPO
AGENDA

Author emails ALL Graphics staff (graphics@ctps.org)
that a document will be available soon.

When document is 
sent to editingALERT GRAPHICS

Tuesday-Wednesday 
of the week preceding 
the MPO meeting

Graphics staff CREATES FINAL PDF (with letterhead) and HTML  
versions of document and VERIFIES accessibility.

CREATE PDF & 
HTML DOC.

Thursday of the week 
preceding the MPO 
meeting

Graphics staff gives PDF and HTML versions to the author 
and informs MPO Activities that document is ready for 

posting on website. 
NOTIFY

Thursday of the week 
preceding the MPO 
meeting

Appropriate party4 PLACES PDF and HTML versions of 
the document on website.

PLACE ON
WEBSITE

Immediately after
posting

MPO Activities staff emails a CONFIRMATION to author 
and Graphics that document has been posted.

SEND
CONFIRMATION

AUTHOR GRAPHICS MPO ACTIVITIES
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Download the presentation template (PowerPoint) from the CTPS intranet 
(https://intranet.ctps.org/presentations) and create your presentation.

DESCRIPTIONACTION BY
AUTHOR

Email PowerPoint to ALL Graphics staff (graphics@ctps.org). Graphics will 
review the presentation, checking for inconsistencies and quality (resolution) 
of images, adding images where applicable, and suggesting transition and 
layout improvements. Then Graphics will return the presentation to the author.

Review Graphics’ suggestions or changes. Send the PowerPoint back to 
Graphics as needed for additional corrections or changes.

Email PowerPoint to ALL Editorial staff (editorial@ctps.org). Editorial will 
review the presentation, checking for typos, spelling, grammar, syntax, and 
proper use of acronyms. Then Editorial will return the presentation to the author.

Review Editorial’s suggestions and changes. If needed, return the PowerPoint 
back to Editorial for additional corrections or changes until the presentation 
is final.

March 2024

Send finalized PowerPoint to MPO Activities Assistant Planner for compiling into 
the composite meeting slide deck by 12PM the day before the meeting.

SLIDE DECK PRODUCTION PROCESS

DEVELOP 
DRAFT 
PRESENTATION

SEND 
POWERPOINT
TO GRAPHICS

ADDRESS 
GRAPHICS’ 
SUGGESTIONS

SEND 
POWERPOINT
TO EDITORIAL

ADDRESS 
EDITORIAL’S 
CHANGES

SEND POWER-
POINT FOR
COMPILATION
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Author File Name
2021-10-28 Early-Morning Transit Service MEM JB 1

Editor File Name
2021-10-28 Early-Morning Transit Service MEM JB 1a

Early-Morning Transit Service

Document Name
(Recognizable, 

descriptive, and brief)

MEM

Product Type
Suffix

(See below)

JB

Author 
Initials

1,2,3, or FINAL

Version

2021-10-28*

Date Submitted 
to Editorial

*MUST be the same as the 
date of online submission

CTPS Product Type Suffixes

ALT = Alternative Text LTR = Letter PPT = Presentation TIP = TIP

BRO = Brochure LGL = Legal Notice PRR = Press release TXT = Miscellaneous Text

FIG = Figure LRTP = LRTP REP = Report UPWP = UPWP

FLY = Flyer MAP = Map SCP = Scope WEB = Web Content

JAD = Job Ad MEM = Memo TBL = Table

F ILE-NAMING 
CONVENTION
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